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CHAPTER 1: INSTALLATING BACKUP PRO

INTRODUCTION

Hard drive crashes, viruses and other data-erasing disasters can happen any time. With BackUp Pro you 
are more than prepared. It's not enough to make backup copies of important files, you need to place 
them in a different location than the original files. That way, if your hard drive fails, you can retrieve 
your important files or sensitive data from a network drive, backup drive, FTP account, flash card or 
even a web-based email account such as Gmail or Yahoo.

BackUp Pro will backup your important files to multiple locations on a given schedule, compress your 
files, encrypt your files, and restore everything seamlessly.

INSTALLATION

BackUp Pro installs in a few easy steps:

1. Download your licensed copy of BackUp Pro and save to it your desktop. This is the Windows 
Installer package.

2. Locate and double-click the BackUp Pro Windows Installer package (i.e. BackUpPro.msi)
3. BackUp Pro will begin installing and you need only follow the directions on the screen.

Note: If you see a Windows warning during the installation process please disregard this warning and 
continue the installation process.
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CHAPTER 2. CREATING BACKUPS

GETTING STARTED

This program operates by creating "Backup Items" which store information about specific files and 
folders. Once you have created a backup item you can add files and folders to it, specify destinations 
for the files to be backed up to, and restore the files in that backup item at any time.

CREATING A BACKUP ITEM

Click the "New Item" button. 

Enter a name for your backup item. This must be unique in your list of backup items. The more 
descriptive the name, the better. 

Choose  files  or  folders  to  backup.  You  can  add  as  many  folders  or  files  as  you  want,  but  we 
recommend keeping things organized by using several smaller backup items if possible. 

To add a folder click the "Add" button and select "Folder". Then browse the folder you want to add. 

To add files click the "Add" button and then select "Files". Select the files you want to add. 

You can do this repeatedly to add more files or folders. 

If you want to include or exclude certain files you can do so using the Include Masks and Exclude 
Masks. The wild card character is an asterisk(*). If you want to work with all files you can skip this 
step. 

Choose your destination. You can choose a local or LAN Folder (including remote shares), an FTP 
server, or an email account.

Local/LAN Folder 
Click "Add New Destination"

Select "Local/LAN Folder"

Browse to the folder you want to backup to and select it.

Press OK to add the folder to your list of backup destinations. 
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FTP Location 
Click "Add New Destination"

Select "FTP Location"

Enter your FTP server's address, username, password and port. You can type the 
location of the folder you want to backup to on the FTP Server, or click the "..." button 
to connect to your FTP server and browse folders.

Press OK to add the FTP location to your list of backup destinations. 

Email Address 
Click "Add New Destination"

Select "Email Address"

If you haven't already filled out your mail server information in the General 
Preferences screen, you will be prompted to do so. Follow the advice in the Tips 
section for configuring your mail server settings. Close the settings window, settings 
are saved automatically.

You can use the "Send Test Email" button to send a test email to the address specified, 
using the server information you specified. Make sure you are properly receiving the 
test message before continuing.

Type the email address you want to send the files to.

Press OK to add the email address to your list of backup destinations.

ADDITIONAL FEATURES TO ENHANCE YOUR BACKUP

Rotation
You can choose to rotate destinations each time your backup item is backed up, or backup to every 
destination each time. Click Next. 

Timestamps
Adding timestamps to your backups will place all your backed up files into folders with the date and 
time in their name. This helps to identify when the files were backed up, and also allows you store 
multiple backups (files in folders with different names won't be overwritten by subsequent backups). 

Timestamp Settings
You can choose the accuracy of your  timestamps.  Essentially,  this  is  how often you want  to  stop 
overwriting older backups. For example, if you chose "month", then each time a new month passes a 
new backup folder will be created. Then, all month long, each time you run the backup item the files 
will replace any existing files that were backed up this month. When a new month comes, the most 
recent files for the previous month will be kept and the program will start writing files to a new folder. 
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You can also choose to have the program delete old versions automatically to save space in your 
backup location. Note that the program cannot delete files backed up to an email address. 

Compression Type
The program can use .ZIP compression to reduce the size of your files and preserve space in the backup 
location. You can choose not to zip file if you want easy access to them using this program, or select 
one of the two compression options. The "many .ZIP files" option will compress each file individually. 
This reduces the chance that a .ZIP file might become corrupt, and is easier to upload to a remote server 
or send VIA email address. If you choose "one .ZIP file" you can store all your files in one .ZIP file. 
This is good for backup to Local or LAN folders. 

Encryption
The  program  can  use  Blowfish  compression  to  obscure  the  data  in  your  files  and  make  them 
unreadable. In order to restore the files you will need to restore them through this program, or use the 
encryption tool in the "Tools" menu to decrypt them. We recommend that you only use encryption for 
particularly important files, because it will increase the time that it takes to backup and restore your 
files. 

Scheduler
You can set up schedules for this backup item to run. You must check the "Enable Scheduler" checkbox 
in order to enable schedules for this backup item. Choose a date and time for the schedule to first run. If 
you want the schedule to run more than once you should check the "Run Schedule" checkbox and 
select a period (Daily, Weekly or Monthly) for the backup to be run. The backup will be run in the 
period you specify at the time you specified. 

IMPORTANT: The program must be running in order for schedules to be executed. We recommend 
turning on "Run at Startup" in the "File > General Preferences" menu to ensure that the program is 
always running. ALSO: We highly recommend separating each schedule by at least 10 minutes to allow 
all previous backups to complete before beginning a second one. 

You're Finished! Click the "Finish" button to add the backup item to the main program window.

DELETING AN ITEM

Click your item in the list to select it. The "Delete" button should become enabled. Click the "Delete" 
button to delete your item. You will be prompted to confirm your choice. Please note that this only 
deletes your backup item, it does NOT delete any files that you have backed up using this item, and it 
does NOT delete the original files you were backing up. 

SETTINGS

Click  your  item in  the  list  to  select  it.  The  "Settings"  button  should  become  enabled.  Click  the 
"Settings" button to open the settings window for this particular item. Alternately, you can double-click 
any item to open its settings window. We recommend performing a fresh backup after changing settings 
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to test the new settings.
RUNNING YOUR BACKUP MANUALLY

Click your item in the list to select it. The "Backup" button should become enabled. Click the "Backup" 
button and your backup item will run. We recommend testing each backup item to ensure it is properly 
configured. 

RESTORING A BACKUP

Click your item in the list to select it. The "Restore" button should become enabled. Click the "Restore 
Button" to open the version list window. This window shows you every version of your backup files 
that is available. Select the version you want to restore and click either "Restore to Previous Location" 
or "Restore to New Location". If you chose "Restore to New Location" you will be prompted to specify 
the new location for the files to be restored. Otherwise the restoration will begin. If the files you are 
restoring already exist you will be prompted to overwrite them or keep them. 

IN THE EVENT OF A HARD DRIVE CRASH

To quickly and easily restore your files in the event of a complete hard drive crash, we recommend the 
following:

● Create a new backup item called "Backup Program"
● If you received registration information, save it in a file. Otherwise you can skip this step. 
● Add this program's installer (.MSI) file, the registration information file that you just created, 

and the  program's "Data"  folder  (which  can be  found in the  same folder  you installed  the 
program in) to the backup item. 

● (Note: If you are unsure where the installer is located on your hard drive, click Start > Search > 
For Files and Folders and search for "*.msi" without the quotes. When the installer is found 
copy it to a location you will remember.) 

● Choose a destination that is NOT on the same hard drive as the above files. A different drive or 
FTP server is best. If you do not have access to either, a free online email account or a different 
drive partition is second best. 

● Choose not to encrypt or compress the backup item, and choose a regular schedule for the 
backup item to run. 

This way, in the event that your entire hard drive should fail, you can reformat your hard drive, reinstall 
windows, reinstall this program and manually restore the "Data" folder from backup. From that point 
on you can use the program to easily and quickly restore all your backed up files.

UNDERSTANDING THE MENU

File Menu
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New Item: Creates a new backup item

Backup: Performs a backup of the selected backup item

Restore: Opens the version list to begin restoration of the selected backup item

Delete: Deletes the selected backup item

Settings: Displays the settings of the selected backup item

General Preferences: Opens the general preferences window

Exit: Exits the program

Tools Menu

File Extractor: Allows you to manually extract files from .ZIP files in the event that you cannot 
restore them automatically with this program

File Decryptor:  Allows you to manually decrypt encrypted files (.bf) in the event that you 
cannot restore them automatically with this program

Help Menu: Displays the help file and readme information 

About Menu: Displays information about this program

GENERAL PREFERENCES

Email Configuration

Mail Server
This is the server you intend to send mail THROUGH, not necessarily the server you want to 
send the mail TO. It will generally be mail.server.com or smtp.server.com.

Port
Mail ports are generally 25 or 1025, but can be any number.

Email From:
The email address you want to send files from. Should match the server address.

Email To:
The email address you want to send files to. Can be any email address and does not have to 
match the server.

Username/Password
If your server requires authentication to send mail, fill in your username and password
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Use Authentication
If your server requires authentication to send mail, check this box

Test
Sends a test message using the information you have entered

Default FTP Values
This area stores your default FTP server information so that you don't have to type it every time you 
add an FTP backup location.

Default LAN Backup Folder
This area stores your default LAN backup folder so that you don't have to type it every time you add a 
new LAN backup location

Startup Options

Open minimized to the system tray
If you would like the program to be unobtrusive when running you can have it open to the 
system tray.

Don't show the splash screen
If you would like the program to be unobtrusive when running you can have it not show the 
splash screen when opening.

Exit Options

Don't show a reminder when I close the program
Prevents the program from reminding you that it is still running in the system tray

Always exit completely when I close the program
Prevents  the  program from continuing to run in the system tray (closing the program now 
disables scheduled backups until you start the program again)

IMPORTANT FILES TO BACKUP

The following is a list of the essential files that you should consider backing up using BackUp Pro: 

● This program's installer (.MSI file), registration information, and "/data/" folder (see above) 
● Digital photos 
● Digital music you have purchased 
● Tax and other financial information (MS Money, Quicken, Etc...) 
● Business Documents 
● Email Folders
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Other files you should consider backing up:

● Program Installers (if you have the space this can save days of tracking down programs). Most 
newer hard drives have more than enough storage space to allow you to copy entire CDs to your 
hard  drive  and  back  them up.  You  might  also  consider  creating  ISO  files  from your  CD 
collection. 

● The System Registry (see http://support.microsoft.com/default.aspx?scid=kb;en-us;322756 ) or 
backup the "config" folder in the Windows System Folder and the "NTUSER.DAT" file in your 
Profile "C:\Documents and Settings\[your username]\NTUSER.DAT" 

● The entire Windows System Folder (in the event that a file is corrupted you can easily restore it 
from backup)

Here is a list of files you should consider backing up. You may think of additional files you'll want to 
back up, so it's a good idea to think about it and make a list before you start. This article applies to 
Windows XP users using all Service Packs. 

Internet  connection information.  The first  thing that  you'll  want  to  take  note  of  in  the  Internet 
connection category is your ISP's phone number if you are using a 56K modem. Open the Network 
Connections folder from the Windows Start.  You can then right-click on your ISP connection, and 
select  Properties  from the  shortcut  menu.  You  can  then  copy down  the  telephone  number  in  the 
connection's dialog box. 

The next things that you may want to take note of are your IP numbers. If your ISP requires you to use 
specific  IP  numbers,  you'll  find  them  by  double  clicking  your  ISP  connection  in  the  Network 
Connections window or by clicking the LAN icon in the notification area on the bottom right of your 
screen. Click the Support tab and you can write down all the TCP/IP Settings numbers that you find on 
the page. 

Instead of writing down the information, you can take a screen capture of each dialog box. To do so, 
you simply open the desired dialog box and press Print Screen. Then launch Paint, pull down the Edit 
menu and select Paste. In a couple of seconds, Paint will display a copy of the dialog box. At this point, 
you can pull down the File menu and click the Print command. You'll then have a printed record of the 
information. 

Internet URLs. In addition to your connection information, chances are that you want to save your 
Web site shortcuts or URLs. For example, if you're using Internet Explorer, you'll find the URLs in the 
C:\Documents and Settings\CNETAU\Favorites folder (assuming that your user name is CNETAU). 
Simply back up the entire Favorites folder to tape or floppy disk. 

If you're using another browser or operating system, check with your documentation to find out where 
and how your URLs are stored. Then, back them up. 

E-mail folders and address books. If you want to keep your address book and e-mail folders intact, 
you'll need to back up the corresponding files. For example, if you're using Outlook Express, you'll 
track down your address book by using Find to search for a file with the extension WAB. You'll then 
track down your e-mail folders by using Find to search for a folder called Mail. This folder contains all 
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your e-mail folders as well as links to any newsgroups that you subscribe to. If you're using another e-
mail program, check with your documentation to find out where the files containing your e-mail folders 
and address book are stored. Then, back them up. 
Trillian/ICQ contacts and logs. If you are a hardcore instant messaging person, you may want to store 
a database of your buddies and back up all the exchanges you've had with your colleagues, friends or 
family. Go to C:\Program Files\Trillian\users\default and store Buddies.xml and the Logs folder. 

For ICQ, your contact list and history logs are can be found at C:\Program Files\ICQ\200Xz (where X 
is the number and z is the letter of your particular version). Back up your contact list by making a copy 
of this database folder related to the version of ICQ you use. 

Documents, music,  videos, pictures,  icons, WAV files.  Ensure that you back up all  your favorite 
songs, movies, pictures and essential documents right away. You don't want to spend hours working on 
a project, downloading music or videos, taking photos, plus your cool icons and WAV files only to lose 
them. Backing up these files guarantees you'll be able to restore your customized user interface to 
current form easily. 

Updates and patches. If you've downloaded any updates or patches to your operating system or to 
your applications, you'll want to make sure that you back up those files individually so you can easily 
update without having to download the updates or patches again. 

Shortcuts or scripts. If you've created any special shortcuts or script files, you'll want to track them 
down and back them up. Doing so will save you from having to recreate them from scratch. 

Programming files. If you are a programmer, DO NOT forget to backup up all those files with .java or 
.vb extensions if you are a Java or Visual Basic person. The same applies to others such as Flash or 
SQL files too. After those countless late nights spent at the computer, don't  spend even more time 
coding them again. 

Start menu organization. If you've spent a lot of time customizing and organizing your Start menu's 
structure, you won't want to have to recreate it. Take a few moments to write down the names and 
sketch the menu's organization. You can also take note of your customization settings for Taskbar and 
Start Menu options by right-clicking on an empty area in your Start menu and selecting Properties. 

Application information. If you're using Microsoft Office or some other application suite, you should 
also back up any templates, macros, or other customized items that you don't want to have to recreate. 
For example, suppose that you're using Word and you've created a lot  of macros that help you to 
quickly an easily produce your documents. You'll find most of your macros stored in Word's templates. 
By default, macros are stored in the Normal.dot template. If you've created a custom template for your 
word processing needs, the template also probably has macros stored in it. 

If you use and have added personalized entries to the AutoCorrect utility, you'll want to back up the 
AutoCorrect files as well. To do so, use Find to track down the ACL files on your hard drive. You 
should be able to find all the ACL files in your Windows folder. 

If you're using another office suite with similar functions, you'll need to refer to your documentation for 
more information on which files you need to back up. Don't forget to check the company's Web site if 
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you don't find the information in the documentation.

CHAPTER 3. TROUBLESHOOTING BACKUP PRO

COMMON PROBLEMS

● The program won't work and I'm getting a Runtime error '429' message. What do I do?
● Error 1931: Cannot update a system file
● None of my test emails are working properly. What should I do?
● Error 1309: Error reading from the file [filename]. Verify that the file exists and that you can 

access it.
● Run-time Error 13: Type Mismatch
● Files backed up to FTP are 0 kb instead of their actual file size.
● I  am still  having problems connecting to my FTP account and my test  emails are still  not 

working properly. Could this be a firewall issue?

The program won't work and I'm getting a Runtime error '429' message. What do I do?

This error message, usually accompanied with text such as 'ActiveX component can't create object'. 
This means that a system file has not been properly registered or has been removed from your system. 
Sometimes  this  happens  when  an  uninstaller  for  a  different  program accidentally  removes  a  file 
BackUp Pro installed. A simple reinstallation of the software will fix this.

Error 1931: Cannot update a system file

This error can occur for a number of reasons:

● Another application is currently using the file. 
● You may have an outdated version of a Windows operating system component. Most frequently 

this is Internet Explorer, and updating to the most current version will solve the problem.

In both cases you can ignore the error because the file is already installed on your computer.

None of my test emails are working properly. What should I do?

Contact your Internet Service Provider and ask them what their settings are. Typically you can find 
their  email  settings  online  at  their  website  but  oftentimes  some  broadband  companies  (such  as 
Cablesystem and Comcast) require you to call in and request your email address from them. They will 
then set it up for you and you need only enter the information they give you into BackUp Pro's main 
settings.
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Error 1309: Error reading from the file [filename]. Verify that the file exists and that you can 
access it.

This can happen when you have saved the installer (.MSI) in your Temporary Internet Files or another 
folder that does not deal well with additional temp files.

To  fix  the  problem  simply  save  the  installer  to  a  different  directory  like  your  Desktop  or  My 
Documents folder.

Run-time Error 13: Type Mismatch

The solution to this error is simple. Go into your Program Files on your Hard Drive (C:\Program Files) 
and delete the entire BackUp Pro directory (the folder that says BackUp Pro). Now try to reinstall the 
software and it will work just fine.

Files backed up to FTP are 0 kb instead of their actual file size.

This can be an indication that your connection is being blocked somehow.

The first thing to do is turn on passive connections to your FTP server. To do this, click you backup 
item and select "Settings".

Select the Backup Locations tab.

Select your FTP location from the list and click "Details".

Place a check mark in the box labeled "Passive Mode".

Click OK in both windows to save your settings.

Run the backup again to test passive mode (which avoids using specific ports on your computer and the 
server).

I am still having problems connecting to my FTP account and my test emails are still not working 
properly. Could this be a firewall issue?

It absolutely could!  If you believe a firewall is blocking access the first thing you should check is 
Windows Firewall.

Click Start > Settings > Control Panel > Windows Firewall

If the firewall is enabled ensure that "Don't allow exceptions" is not checked.

Then click the "Exceptions" tab.
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Look through the list to see if BackUp Pro is already listed as an exception (meaning that it is allowed 
to connect to the Internet).
If it is not, click "Add Program". Select BackUp Pro from the list, or browse to your program files 
folder and find the executable (.exe) file.

Now Windows Firewall should let that program connect to the Internet.

Other  popular  firewalls  can  also  block  programs  from accessing  the  Internet.  Norton  Antivirus's 
"Internet Worm Protection" is actually a firewall. Try disabling it to see if the problem is resolved. 
Other popular firewalls are ZoneAlarm and Black Ice, both of which will block all third-party software 
unless you give it instructions to do otherwise.

GETTING HELP

Oversight Technology offers many support options to licensed users.

Support Center: http://www.oversightcorp.com/support/

FAQs: The Houdini Frequently Asked Questions is kept updated and can answer 
most  questions  right  away.  Please  visit  the  Houdini  FAQs  at 
http://www.oversightcorp.com/support/faqs-backup.php

User Guides: Check to make sure you have the most recent version of this guide 
and download manuals for other Oversight Technology products.

Help  Desk:  Still  need  help?  Open  a  ticket  and  a  support  representative  will 
resolve  your  problem  within  24  hours.  Visit  the  help  desk  at 
http://www.oversightcorp.com/helpdesk/
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